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READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX.

BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE

SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE USER

MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE"”) AND PROMPTLY RETURN THE SOFTWARE TO

YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions

of this Agreement.

1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be downloaded
to the applicable Canon digital camera product, Canon grants you a personal, non-exclusive license to use
the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for
back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. You must
reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for
providing maintenance or support for use of the SOFTWARE. ‘No updates, fixes or support will be made
available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: [t is your responsibility to choose, maintain and
match the hardware and software components of your computer system. Thus Canon does not guarantee
uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet
your requirements. THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR
CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM. The limited warranty does not apply if the failure of the CD-
ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other
than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR
ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUEN-
TIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVEN-
IENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE
ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY
ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY
OF SUCH THIRD PARTY.



SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE ON
THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO
YOU.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of
all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by
destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply
with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition,
Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:

The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting of
“commercial computer software” and “commercial computer software documentation,” as such terms are
used in 48 C.FR. 12.212 (Sept 1995). Consistent with 48 C.FR. 12.212 and 48 C.F.R. 227.7202-1 through
227.72024 (June 1995), all U.S. Government End Users shall acquire the SOFTWARE with only those rights
set forth herein. Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501,
Japan.

7. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and regulations of the
country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of any such
laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:

In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of
competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or
tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

9. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United
States of America shall be governed and construed in all respects in accordance with the laws and
regulations of the State of New York, without reference to choice of law principles. The terms of this
Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the
province of Ontario.

10.OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE
belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to
the laws of the United States, and Canada, and other applicable copyright and trademark laws, and nothing
in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party
licensors under such laws. You only own the CD-ROM media in which the Software is stored. Except as
expressly provided herein, no license or right, express or implied, is hereby conveyed or granted by Canon to
you for any intellectual property of Canon. Nothing contained in Paragraph 1 shall be construed to give
Canon any ownership rights in any images, graphics or textual material that you save in connection with the
Software.

You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (i) which are on the original CD-ROM and on the medium of a back-up copy
made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ
THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.

[E]
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Read This First

You can connect a camcorder with a USB terminal to the PC using a USB cable
to download still images recorded on the memory card of the camcorder. You
can also use the software provided to sort, store, and print still images.

Disclaimer

e While every effort has been made to ensure that the information contained
in this guide is accurate and complete, no liability can be accepted for any
errors or omissions. Canon reserves the right to change the specifications of
the hardware and software described herein at any time without prior
notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any language in any form, by any
means, without the prior written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost
data due to mistaken operation or malfunction of the camcorder, the
software, memory cards (MultiMediaCards or SD Memory Cards), personal
computers, or peripheral devices, or due to use of a memory card not
formatted by a Canon camcorder.

Trademark Acknowledgments

e Canon is a trademark of Canon Inc.

e ArcSoft, the ArcSoft logo, ArcSoft Photolmpression and ArcSoft
Videolmpression are trademarks or registered trademarks of ArcSoft, Inc.

e Adobe, Adobe Acrobat and Adobe Photoshop are trademark of Adobe
Systems Incorporated.

¢ iBook and iMac are trademarks of Apple Computer, Inc.

¢ Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of
Apple Computer Inc., registered in the United States and other countries.

o Microsoft, Windows and Windows NT are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other
countries.

e Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

Copyright © Canon Inc. 2002 All rights reserved.

Safety Precautions

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss
from listening with headphones to the loud sounds of a CD-ROM played on
a music CD player.



Checking Supplied Accessories

Use the following accessories to download recorded images from a memory IE
card to your computer.
¢ [FC-300PCU USB Cable — @)
(=)
\%\m\f

Qmﬂ“
e Canon DIGITAL VIDEO SOLUTION DISK
e ArcSoft Camera Suite CD Q
-

- Windows users: Move on to p. 8.
- Macintosh users: Move on to p. 69.




System Requirements

Please install the software on a computer meeting the following minimum
requirements.

Computer Model: IBM PC/AT compatible
0s: Windows 98 (First or Second Edition)
Windows Millennium Edition (Windows Me)
Windows 2000
Windows XP
* Proper operation is not guaranteed on an OS that
has been upgraded from a previous version.

CPU: Pentium 150 MHz or better
Windows XP: Pentium 300 MHz or better
RAM: Windows 98: 32 MB or more

Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more
Interface: USB: only preinstalled Windows 98/Windows Me/
Windows 2000/Windows XP systems with built-in
USB ports
Free Hard Disk Space: e Canon Utilities
- ZoomBrowser EX: 120 MB or more (Including the
PhotoRecord printing program)
- PhotoStitch: 40 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more
e ArcSoft Photolmpression: 125 MB or more
* ArcSoft Videolmpression: 30 MB or more
Display: 800 x 600 pixels/256 colors (8 bit) or better, 1,024 x
768 pixels/High Color (16 bit) or better is
recommended
(800 x 600 pixels/High Color (16 bit) is required to
use ArcSoft Photolmpression or ArcSoft
Videolmpression)

® The USB interface is only supported for those computers that come with
Windows 98/Windows Me/Windows 2000/Windows XP preinstalled and have
built-in USB ports.

* Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.

* Proper operation is not guaranteed for all computers that meet the above
requirements.

e A CD-ROM drive is required to install the software.

e Connect the USB cable directly to one of the computer’s main USB ports. The
interface may not function correctly if the camcorder is connected via a USB hub.

¢ The connection may not operate correctly if you are using other USB devices,
excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

¢ Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.




What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the CD-ROMs. (E]

Canon DIGITAL VIDEO SOLUTION DISK

B USB TWAIN Driver (Windows 98, Windows 2000)
This driver for Windows 98/Windows 2000 loads camcorder still images/
movies into TWAIN-compliant programs, such as ArcSoft Photolmpression.

B USB WIA Driver (Windows Me, Windows XP)
This driver for Windows Me/Windows XP starts the Scanners and Cameras
Wizard to automatically download camcorder still images/movies to the
computer. It also allows you to copy camcorder still images/movies using
standard file copying procedures in Windows Explorer (but it cannot upload
computer files to the camcorder).

B ZoomBrowser EX (11 37)
¢ Downloading still images/movies from a memory card to your computer.
e Categorizing and Organizing Large Volumes of Images*.
e Searching and Organizing Images Chronologically*.
e Creating Mail Attachments from Images*.

B PhotoRecord ( 1 57)
e Laying Out and Printing Still Images.
e Printing Indexes.

M PhotoStitch (11 60)
e Merging Panoramic Images.

*: For instructions on these features, refer to the ZoomBrowser EX Software
User Guide.

How to view the ZoomBrowser EX Software User Guide

In order to view the ZoomBrowser EX Software User Guide, it is required that
Adobe Acrobat Reader is installed on your computer. If it is not, install it
according to “How to install Adobe Acrobat Reader” below.

1. Place the Canon Digital Video Solution Disk in the computer’s
CD-ROM drive.
The installer panel will be displayed.

2. In the installer panel, click [ZoomBrowser EX Software Guide].
The guide will be displayed.

¢ [f the installer panel does not appear automatically, open the [Readme] and
[English] folders on the CD-ROM and double-click the [ZOOMBROWSER EX
GUIDE.PDF] file.
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What Can Be Accomplished with the Software

How to install Adobe Acrobat Reader

1. Place the Canon Digital Video Solution Disk in the computer’s
CD-ROM drive.

2. Open the [Readme], [Acrobat-English] folders.

3. Double-click the [ar405eng.exe] file to start the installer.

Follow the on-screen instructions to install Adobe Acrobat Reader.

ArcSoft Camera Suite CD-ROM

B ArcSoft Photolmpression
This program allows you to easily convert still images to sepia color, apply
other special effects, or to edit them and create greeting cards and
calendars.

B ArcSoft Videolmpression
This program provides simple procedures for editing and applying special
effects to movies, or attaching them to your e-mail.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed
operational instructions, refer to the ZoomBrowser EX Software User Guide
(PDF format) or the Help menu of each software program.



Installing the Software

Installing from the Canon DIGITAL VIDEO SOLUTION DISK

Installation Precautions

e Before you attach the camera to the computer with the USB cable for the first
time, you must install one of the following drivers onto the computer.
Windows 98/Windows 2000:  USB TWAIN Driver
Windows Me/Windows XP: USB WIA Driver
e There are several limitations to the USB WIA Driver. Before you install it, please
read the "USB WIA Driver Installation Precautions” ([J1 14).

1. Close any programs that are running.

e Users of Windows 2000, Windows XP Professional must first log in as
an Administrator to install programs.

2. Set the Canon DIGITAL VIDEO SOLUTION DISK in the
computer’s CD-ROM drive.

e The installer panel opens automatically.
e [f the installer panel does not appear automatically, use the following
procedures to display it.
1. Double-click the [My Computer] icon on the desktop to open it and
double-click the CD-ROM icon.
2. Double-click the [Setup] icon.

3. Click [Digital Video Software Installation].

canon

Installer Panel

SOLUTION DISK

4. Read the license agreement and click the [Yes] button.

5. Confirm the target folder for the installation and click the
[Next] button.

e Normally, select (C:\Program Files\Canon).
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Installing the Software

6.

8.

9.

Confirm the program selection and click the [Next] button.

¢ The installation starts.

e Follow the on-screen messages to proceed with the installation.

e |f the “Digital signature not found” message appears, click the [Yes]
button.

Select your camcorder model name and click the [Next]
button.

Select Components

AN

After the installation is complete and the installer panel
displays again, click the [Exit] button.
e The installer panel disappears.

Remove the DIGITAL VIDEO SOLUTION DISK once the
installation is complete so that the proper driver may be
installed.

(@ Notes:

e The DIGITAL VIDEO SOLUTION DISK is not needed for installing the USB
driver. Remove the disk once the installation is complete.

e Continue with the procedures on page 14 to install the driver software to
allow the camcorder to be connected to a computer via the USB interface
and download images.

e For uninstalling programs contained in the DIGITAL VIDEO SOLUTION DISK
such as the ZoomBrowser EX, see “Uninstalling the Software” (11 66).



Installing from the ArcSoft Camera Suite CD-ROM

[E]

1. Place the ArcSoft Camera Suite CD-ROM into the drive.

2. Double-click the [My Computer] icon on the desktop
(Windows XP: click the Windows [Start] menu and select [My
Computer]) followed by the [ArcSoft] folder and [Setup]
icon.

3. Select your language and click [OK].

* You can select the software you wish to install. ArcSoft Photolmpression
is a software for still images and ArcSoft Videolmpression for movies.
e Follow the on-screen instructions.

e For uninstalling ArcSoft Photolmpression or ArcSoft Videolmpression, see
“Uninstalling the Software” (11 66).

13
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

The installation procedures vary depending on the computer. Check your OS
and proceed to the referred pages.

Windows 98 (11 15), Windows Me ( 11 20), Windows 2000 ( 11 24),
Windows XP (11 29).

USB WIA Driver Installation Precautions

® You can install the USB WIA Driver if you are using Windows Me/Windows XP. In
addition, you should read the “USB WIA Driver Limitations” below before
installing the driver.

USB WIA Driver Limitations

¢ When you have set the WIA Driver to start a particular application program when
you connect the camcorder, the program may cause an error message similar to
the following to appear: “TWAIN data source not found. Reinstall the scanner
software.” If this happens, select [WIA-camera model] in the application program
as the TWAIN device.

(#) Notes:

e USB TWAIN Driver is the driver software for Windows 98 and Windows
2000 that is required to load still images/movies into TWAIN-compliant
programs, such as ArcSoft Photolmpression and ArcSoft Videolmpression.
Since it is not a stand-alone program, you must always start it from TWAIN-
compliant programs.

e USB WIA Driver can only be used with the USB interface in Windows Me/
Windows XP. When you connect the camcorder to the computer with a USB
cable, the Windows Scanners and Cameras Wizard opens automatically to
assist with downloading. This driver also allows you to use Windows
Explorer to display thumbnails of the camcorder’s still images/movies on the
computer and download still images/movies with standard file copying
procedures.

e [f the “Digital signature not found” message appears, click the [Yes] button.



Installing the USB TWAIN Driver

1.
2.

3.

Connect the Power Adapter to the camcorder.

Connect the camcorder to the computer using the supplied
USB cable (1] 36).

Set the camcorder to CARD PLAY (VCR) mode.

e After a moment, a dialog appears, prompting you to insert the DIGITAL
VIDEO SOLUTION DISK.

Without inserting the DIGITAL VIDEO SOLUTION DISK, click
[OK]. The following dialog appears.

Click the [Browse] button.
e The [Choose Folder] dialog appears.

Double-click the drive on which you installed the software
(such as C:), and select the [Program Files], [Canon] and
[IXY DV3 ELURA40 TWAIN] folders.

When you have selected the folder, click [OK].
e This brings you back to the dialog in step 5.

Windows 98 15



Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

8.

Click [OK]. The USB TWAIN Driver will be installed
automatically.

Uninstalling the USB TWAIN Driver

1.
2.

Connect the Power Adapter to the camcorder.

Connect the camcorder to the computer using the supplied
USB cable (1] 36).

Set the camcorder to CARD PLAY (VCR) mode.

e A dialog appears, allowing you to select an application program to
start.

Click the [Cancel] button.
e |f ZoomBrowser is started, close it.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [Scanners and Cameras] icon.

e |f you cannot find the [Scanners and Cameras] icon, use the procedures
on page 17 to uninstall the driver.

Delete the camcorder model name from the [Scanners and
Cameras Properties] list.

Scanners and Cameras Properties 7] x|

Devices | Logging sellmgsl

% The following scanners or car

Tl D3 ELURA4D

meras are installed

Your camcorder model name
appears here. If it does not, use
the procedures on page 17 to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.

Add... Bemove Properties

Cancel

e Select the name of your camcorder model and click the [Remove] button.

16 Windows 98



8. Click the [Start] menu and select [Programs], [Canon
Utilities], [IXYDV3, ELURA40 TWAIN Driver] and [TWAIN
Driver Uninstall].

e The uninstall process starts.

Troubleshooting the USB TWAIN Driver Uninstall

If you had problems uninstalling the driver, use the following procedures to
remove it.

(@) Notes:

Use the procedures below for the following circumstances too.

e If you do not find the [Scanners and Cameras] icon in the [Control Panel].

e |f your camcorder model name does not appear in the [Scanners and
Cameras Properties] dialog.

e If you connected the camcorder to the computer via the USB cable before
installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Leave the camcorder connected to the computer.

1. click the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
e The [System Properties] dialog appears.

3. click the [Device Manager] tab.

Windows 98

17
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

4. 1f your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

<E;; 5
Check here 4 = 5

1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop
followed by the [C:] drive and the [Windows] and [Inf]

folders.
» B4 LY

R it

tdy Co
If the [Inf] Folder Is Not Visible in the [Windows] Folder
1. Click the [View] menu and select [Folder Options].
2. Click the [View] tab.
3. Set the [Hidden files] section to [Show all files].
4. Click [OK] to close the dialog.
This makes the [Inf] folder and files in the [Inf] folder visible.

Folder Ophions

Gerwel Viem | Fla Ty |

| wiew!|

ﬁbara 3 Foldes views
v Status Bar Weu can make ol s ks Kok, e s
Explorer Bar 3 Flenst Al Folders

v as'Web Page

® Large lcons
Small lcons
List
Details

Customize this Folder.
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6. Find and delete the [Drvdata.bin] and [Drvidx.bin] files. @
7. In the [Inf] folder, double-click [Other] folder to open it.
8. Find and delete the [Canon.IncCAP_IDV3] folder.

¢ If none of the above files are contained in the [Other] folder, you do not
need to delete anything.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

| Windows Me |
Installing the USB WIA Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (1] 36).

3. Set the camcorder to CARD PLAY (VCR) mode.

e After a moment, the Add New Hardware Wizard opens and
automatically installs the USB WIA Driver.

e |f you are prompted to restart the computer, restart the computer
according to the on-screen messages.

If you have installed the USB WIA Driver, the Scanners and Cameras Wizard
starts.

Uninstalling the USB WIA Driver

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (1] 36).

3. Set the camcorder to CARD PLAY (VCR) mode.
e The Scanners and Cameras Wizard appears.

4. Click the [Cancel] button.
e [f ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double-click the [Scanners and Cameras] folder.

e If you cannot find the [Scanners and Cameras] folder, use the
procedures on page 21 to uninstall the driver.
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7. Delete the camcorder icon from the [Scanners and Cameras]

folder.
(3 Scanners and Cameras =101
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the procedures below to Cameras
uninstall the driver. If a scanner
driver has also been installed, its The Scanners and Cameras folder
. . contains all the currently installed
name also appears in the list. devices for mage nput.
2 obiects) 4%

e Select the icon of your camcorder model, right-click the mouse button
and select [Delete].

8. Click the [Start] menu and select [Programs], [Canon
Utilities], [IXYDV3, ELURA40 WIA Driver] and [WIA Driver
Uninstall].

e The uninstall process starts.

Troubleshooting the USB WIA Driver Uninstall

If you had problems uninstalling the driver, use the following procedures to
remove it.

(@) Notes:

Use the procedures below for the following circumstances too.

¢ If you do not find the [Scanners and Cameras] folder in the [Control Panel].

e |f the camcorder icon does not appear in the [Scanners and Cameras] folder.

e If you connected the camcorder to the computer via the USB cable before
installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Leave the camcorder connected to the computer.

1. click the Windows [Start] menu and select [Settings] and
[Control Panell.

2. Double-click the [System] icon.
e The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

Windows Me

[E]
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

4. 1f your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.
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1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop followed
by the [C:] drive and the [Windows] and [Inf] folders.

iInf:

by Compuiter

If the [Inf] Folder Is Not Visible in the

[Windows] Folder
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. Set the [Hidden files and folders] section to [Show hidden files and
folders].
4. Click [OK] to close the dialog.
This makes the [Inf] folder and files in the [Inf] folder visible.
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] ik Drive Fkdes views
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6. Find and delete the [Drvdata.bin] and [Drvidx.bin] files. @
7. In the [Inf] folder, double-click [Other] folder to open it.
8. Find and delete the [Canon.IncCAP_IDV3] folder.

¢ If none of the above files are contained in the [Other] folder, you do not
need to delete anything.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

| Windows 2000 |

Installing the USB TWAIN Driver

0 Users of Windows 2000 must first log in as an Administrator to install the driver.

Connect the Power Adapter to the camcorder.

Connect the camcorder to the computer using the supplied
USB cable (7] 36).

Set the camcorder to CARD PLAY (VCR) mode.

e After a moment, the Add New Hardware Wizard opens and
automatically installs the USB TWAIN Driver.

e |f you are prompted to restart the computer, restart the computer
according to the on-screen messages.

Uninstalling the USB TWAIN Driver

Users of Windows 2000 must first log in as an Administrator to uninstall the
driver.

Connect the Power Adapter to the camcorder.

Connect the camcorder to the computer using the supplied
USB cable (7] 36).

Set the camcorder to CARD PLAY (VCR) mode.
e A dialog appears, allowing you to select an application program to
start.

Click the [Cancel] button.
e |f ZoomBrowser is started, close it.

Click the Windows [Start] menu and select [Settings] and
[Control Panel].

Double-click the [Scanners and Cameras] icon.

e |f you cannot find the [Scanners and Cameras] icon, use the procedures
on page 25 to uninstall the driver.

Windows 2000




7. Delete the camcorder model name from the [Scanners and
Cameras Properties] list.

2
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e Select the name of your camcorder model and click the [Remove]
button.

8. Click the [Start] menu and select [Programs], [Canon
Utilities], [IXY DV3, ELURA40 TWAIN Driver] and [TWAIN
Driver Uninstall].

e The uninstall process starts.

Troublesthinthe USB TWAIN Driver Uninstall

If you had problems uninstalling the driver, use the following procedures to
remove it.

() Notes:

Use the procedures below for the following circumstances too.

¢ If you do not find the [Scanners and Cameras] icon in the [Control Panel].

e |If your camcorder model name does not appear in the [Scanners and
Cameras Properties] dialog.

e |f you connected the camcorder to the computer via the USB cable before
installing the software/driver on the DIGITAL VIDEO SOLUTION DISK.

Users of Windows 2000 must first log in as an Administrator to uninstall the
driver.

1. cClick the Windows [Start] menu and select [Settings] and
[Control Panel].

2. Double-click the [System] icon.
Windows 2000
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

3. Click the [Hardware] tab.
4. Click the [Device Manager] button.

5. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model, right-click the mouse
button and select [Delete].

Check here <>.
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2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.
* Remove all copies of your camcorder model name that appear in
the [Other Devices] or [Imaging Devices] categories, or that appear
more than once in one category.
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6. Double-click the [My Computer] icon on the desktop, @
followed by the [C:] drive, and the [Winnt] and [Inf] folders.

If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders]
category to the [Show hidden files and folders] option.
e |f [Hide extensions for known file types] is selected, remove its
check mark.
4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.
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/. Look for the file starting with [OEM*].

* A number such as “0” or “1” will appear in place of the asterisk (*)
above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

e There may be many file sets starting with “Oem".

e If you double-click the [Oem*] file, the Windows Notepad program will
start and show the file contents. Click each [Oem*] file until you find
one that contains “*** Canon Digital Camera USB SETUP File***" in
its first line. When you find the correct file, note down its name and
close the Notepad window.
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

8. Delete the [Oem*] file set.

e Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the
correct files.

The [Inf] folder contains numerous files that are critical to the computer’s
operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.
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| Windows XP |
Installing the USB WIA Driver

Users of Windows XP Professional must first log in as an Administrator to install
the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (1] 36).

3. Set the camcorder to CARD PLAY (VCR) mode.
e The USB WIA Driver will be installed automatically.

When the installation is complete, select the application you wish to start.

(@ Note:

e Please set your computer to automatically start an application when the
camcorder is connected to the computer. Please set the computer to start
either ZoomBrowser EX or the Scanners and Cameras Wizard. If neither of
these is selected the computer may not operate properly.

Setting an Application to Start Automatically

You can set your computer to automatically start an application when the
camcorder is connected to the computer via the USB cable. Please set the
computer to start either ZoomBrowser EX or the Scanners and Cameras

Wizard. If neither of these is selected the computer may not operate properly.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (11 36).

3. Set the camcorder to CARD PLAY (VCR) mode.
e |f the Event Dialog appears, click [Cancel] to close it.

Windows XP
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

4. From the [Start] menu, click [Control Panel] and the [Printers
and Other Hardware] icon.
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6. Select the camcorder icon and click the [View device
properties] icon in [Imaging Tasks].

The name of your camcorder
appears.




7. Click the [Events] tab. |E|

When you wish to start ZoomBrowser EX automatically
1. Set [Select an event] to [Default]. Set the [Actions] section to [Take
no action].
2. Set [Select an event] to [(camcorder name) Connected] and in the

[Actions] section, set [Start this program] to [Canon ZoomBrowser
EX].

When you wish to start the Scanners and Cameras Wizard automatically
1. Set [Select an event] to [Default]. In the [Actions] section, set [Start
this program] to [Microsoft Scanners and Cameras Wizard].
2. Set [Select an event] to [(camcorder name) Connected], and set the
[Actions] section to [Take no action].

8. Click [OK].

e Next time, either ZoomBrowser EX or the Scanners and Cameras Wizard
will start automatically.

Uninstalling the USB WIA Driver

Users of Windows XP Professional must first log in as an Administrator to
uninstall the driver.

1. Connect the Power Adapter to the camcorder.

2. Connect the camcorder to the computer using the supplied
USB cable (7] 36).
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Installing/Uninstalling the USB TWAIN Driver/USB WIA Driver

3. Set the camcorder to CARD PLAY (VCR) mode.
e The Scanners and Cameras Wizard appears.

4. Click the [Cancel] button.
o |f ZoomBrowser is started, close it.

5. Click the Windows [Start] menu and select [Settings] and
[Control Panell.

6. Double-click the [Scanners and Cameras] icon.

e If you cannot find the [Scanners and Cameras] icon, use the procedures
on page 33 to uninstall the driver.

7. Delete the camcorder icon from the [Scanners and Cameras]

folder.
n (=@
Todke bl o
Qo - B @ Jsewor o rkbs [T
Your camcorder model name rer— .@ 3

appears here. If it does not, use
the procedures on page 33 to
uninstall the driver. If a scanner
driver has also been installed, its
name also appears in the list.

e Select the icon of your camcorder model, right-click the mouse button
and select [Delete].

8. Click the [Start] menu and select [All Programs], [Canon
Utilities], [IXY DV3, ELURA40 WIA Driver] and [WIA D